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1. Uvod

Još od samih početaka ljudske civilizacije zapaženo je da su ljudi bilježili stvar-
nost u obliku vizualnih tvorevina - crteža. S napretkom civilizacije i umjetnosti
razvijale su se nove tehnike, trendovi i pravci u vizualnom izričaju. Slikarstvo
i kiparstvo pored svog umjetničkog značaja služili su kao način bilježenja ljud-
ske stvarnosti, odnosno povijesti. Ljudska naklonost vizualnom izričaju može se
povezati s načinom na koji ljudi doživljavaju svijet kroz osjetila. Naime, kroz
osjetilo vida čovjek prima mnoštvo informacija iz okoline na koje se neprekinuto
oslanja. Izumom fotografije ljudi su dobili alat pomoću kojeg mogu precizno za-
bilježiti određeni vremenski trenutak. Fotografija je postala nezamjenjiv način
evidentiranja povijesti, novi umjetnički pravac te oblik bilježenja vizualnih infor-
macija. Pored korištenja u tehničke, medicinske i poslovne svrhe, fotografijom
se služi skoro svaka osoba u modernoj ljudskoj civilizaciji za evidentiranje svoje
svakidašnjice pomoću kamera na pametnim telefonima. Pored prosječnog koris-
nika, profesionalni fotografi specijaliziraju se u korištenju digitalnih fotoaparata,
umjetnosti fotografije i korištenju alata za manipulaciju digitalnim fotografijama.
Fotografije dobivene iz fotoaparata nisu savršene iz mnogo razloga i postoji po-
treba za dodatnom obradom fotografije nakon što je ona snimljena. Jedan primjer
bio bi povećanje svjetline na fotografiji koja je snimljena pri niskoj svjetlosti (slika
1.1). S druge strane, postoji potreba i za obradom fotografije koje su zadovoljava-
juće kvalitete. Takve obrade obično su svrstane pod umjetnički cilj. Primjerice,
obrada fotografije koja je dobivena modernim digitalnim fotoaparatom tako da
izgleda kao staromodna fotografija dobivena iz starijih fotoaparata (slika 1.2).

Cilj ovog rada jest razmotriti metode obrade digitalne slike te ponuditi alat po-
moću kojeg korisnik može obrađivati fotografije po želji. Sukladno cilju, razvijen
je alat pod nazivom ‘PhotoGrade’ (slika 1.3) čija će se funkcionalnost analizi-
rati te usporedno tome objasniti i razmotriti odabrane metode obrade digitalne
fotografije.
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Slika 1.1: Primjer povećanja svjetline slike

Slika 1.2: Primjer obrađivanja fotografije sepia efektom

Slika 1.3: Primjer korištenja alata PhotoGrade
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2. Prostori boja digitalno
snimljenih fotografija

U ovom poglavlju dan je općeniti uvid u digitalne slike. Koji su gradivni ele-
menti digitalne slike, kakva je njihova struktura, kako se digitalne slike spremaju
na računalu. Objašnjena su dva modela boja koji su korišteni u alatu PhotoGrade
te u procesima obrade slika u daljnjim poglavljima.

Općenito, digitalna slika je slikovna informacija pohranjena u digitalnom
obliku. U širem smislu, digitalna slika može biti vektorska ili rasterska (slika
2.1). Vektorska slika nema definiranu rezoluciju, već su grafičke informacije po-
hranjene u obliku matematičkih funkcija i operacija koje se mogu iscrtati na bilo
kojoj slikovnoj rezoluciji. Digitalne fotografije nikada nisu vektorske stoga ovaj
tip digitalne slike više neće biti razmatran u nastavku. Suprotno vektorskoj slici,
rasterska slika ima točno definiranu rezoluciju širine w i visine h koja se općenito
zapisuje kao w × h. Osnovni element rasterske slike naziva se piksel. Raster-
ska slika reprezentira se kao dvodimenzionalni niz dimenzija w × h u kojemu su
pohranjene vrijednosti piksela. Svaki piksel u slici predstavlja jedan ton boje.

2.1. RGB model boja

Općenito, model boja je apstraktni matematički model koji opisuje kako se
boje mogu reprezentirati kao n-torke [1]. RGB model boja je aditivni model1 u
kojemu se crvena, zelena i plava svjetlost kombiniraju zajedno kako bi se dobila
široka paleta boja [2].

Boja u RGB modelu predstavlja se kao trojka (R,G,B) gdje su R,G i B vrijed-
nosti crvene, zelene i plave respektivno. Svaka komponenta trojke ima vrijednost
između 0 i maksimalne vrijednosti. Maksimalna vrijednost se može razlikovati

1aditivni model boja - konačna boja dobiva se kao suma njenih komponenti
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Slika 2.1: Primjer rasterske slike i rastav piksela na RGB komponente

ovisno kakav raspon komponenata se odabere. Najčešće se uzima raspon [0, 255]
cijelih brojeva ili ponekad raspon [0, 1] realnih brojeva. Potpuna odsutnost kom-
ponente se predstavlja vrijednošću 0, dok se potpuni intenzitet komponente pred-
stavlja maksimalnom vrijednošću. Dakle, trojka (0, 0, 0) predstavlja potpuno crni
ton, dok (255, 255, 255) predstavlja potpuno bijeli ton. Crvena boja se predstav-
lja s (255, 0, 0, 0), zelena s (0, 255, 0) te plava s (0, 0, 255). Ostale boje i nijanse
dobivaju se različitim kombinacijama R, G i B komponenata.

RGB model nije apsolutan model boja budući da iste vrijednosti boje na raz-
ličitim uređajima mogu izgledati drugačije. RGB model se geometrijski može
reprezentirati (slika 2.2) u trodimenzionalnom kartezijevom koordinatnom sus-
tavu kao kocka u rasponu [0, 1] po svim osima.

Slika 2.2: Geometrijska reprezentacija RGB modela
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2.2. HSV model boja

HSV model je alternativna reprezentacija RGB modela koji je bolje usklađen
s načinom na koji ljudi percipiraju boje [2]. U nazivu HSV slovo H predstav-
lja nijansu boje (engl. hue), slovo S predstavlja saturaciju (engl. saturation) te
slovo V predstavlja vrijednost (engl. value). Za razliku od RGB modela koji je
predstavljen u kartezijevom koordinatnom sustavu, HSV model predstavlja se u
cilindričnom koordinatnom sustavu (slika 2.3). Boja u HSV modelu predstavljena
je trojkom (H,S, V ) gdje H predstavlja kut zakretanja u cilindričnom sustavu i
označava nijansu boje, S predstavlja udaljenost točke od Z osi i označava satu-
raciju boje te V predstavlja Z koordinatu i označava svjetlinu boje.

Crvena boja počinje kutom 0◦, zatim se nastavlja do zelene boje pod kutom
120◦ i plave boje pod kutom 240◦, sve dok se ne vrati opet do crvene boje pod
kutom 360◦. Saturacija S predstavlja udaljenost boje od svoje luminantne kom-
ponente. Dakle, saturacija 0 predstavlja nijansu potpuno sivog tona, a saturacija
maksimalne vrijednosti predstavlja potpunu zasićenost boje. Svjetlina V iznosa
0 predstavlja potpuno crnu boju, dok svjetlina maksimalnog iznosa predstavlja
najsvjetliju verziju određene nijanse boje i saturacije. Ako je saturacija boje jed-
naka 0 i svjetlina je maksimalnog iznosa, tada će rezultirana boja u HSV modelu
biti potpuno bijela.

Izravna pretvorba RGB modela u HSV model rezultira time da HSV model
više neće biti cilindričan, već će biti piramida s heksagonalnom bazom. U ovom
radu, za neke metode obrade slike je bilo potrebno napraviti pretvorbu slike iz
RGB modela u HSV model te je navedeno kada se radi s HSV modelom. Ako
ništa nije navedeno, pretpostavlja se korištenje RGB modela.

Slika 2.3: Geometrijska reprezentacija HSV modela
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Pretvorba iz RGB u HSV model radi se prema sljedećim izrazima [3]:

V = max(R,G,B) (2.1)

S =


V−min(R,G,B)

V
ako V 6= 0

0 inače
(2.2)

H =



60(G−B)
V−min(R,G,B) ako V = R

120+60(B−R)
V−min(R,G,B) ako V = G

240+60(R−G)
V−min(R,G,B) ako V = B

(2.3)

Vrijednosti se potom skaliraju na raspon [0, 255]:

V = 255 · V (2.4)

S = 255 · S (2.5)

H = H

2 (2.6)
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2.3. Pohrana digitalne slike u radnoj memoriji

Kao što je već navedeno, digitalna slika se u računalu pohranjuje kao dvodi-
menzionalni niz u kojemu svaki element predstavlja jedan piksel. No, to je samo
slučaj kada se apstrahirano govori o digitalnoj slici. Budući da su pikseli predstav-
ljeni nekim modelom boje, najčešće RGB modelu, koji sadrže više komponenti,
stvarna pohrana u memorije je češće trodimenzionalni niz u kojemu su vrijednosti
vi,j,c gdje je i pozicija po širini, j pozicija po visini te c indeks komponente iz mo-
dela boje. Ako se navedeno trodimenzionalno polje rastavi na dvodimenzionalna
polja po dubini, takva dvodimenzionalna polja se nazivaju kanali slike. Digitalna
slika dimenzija 100 × 200 predstavljena RGB modelom sadrži tri kanala boje:
crveni, zeleni i plavi, gdje svaki kanal ima dimenzije 100× 200.

Kako je memorija u računalu ograničena, a vrijednosti se spremaju kao n-bitni
binarni brojevi, preciznost pohranjenih vrijednosti nije beskonačna. Tako će broj
različitih boja koje digitalna slika može prikazati biti ograničen s duljinom n

zapisa binarnog broja u memoriji računala. Ako se za svaku komponentu modela
uzima duljina od n bita te se koristi model boja koji ima k komponenti, svaki
piksel digitalne slike će zauzimati n · k bita po pikselu.

U praksi se često za pohranjivanje digitalnih slika uzima veličina n = 8 bita
(jedan bajt) po komponenti. Ako se radi o RGB modelu i svaka komponenta
zauzima 8 bita, jedan piksel će biti predstavljen s 8·3 = 24 bita po pikselu. Takva
slika ima tri kanala boje te svaki piksel može prikazati 283 = 2563 = 16777216
različitih boja.

Za pohranjivanje crno-bijelih slika (engl. grayscale) se koristi samo jedan kanal
koji predstavlja svjetlinu sivog tona, gdje je 0 potpuno crna boja, a maksimalna
vrijednost potpuno bijela boja. Ako se koristi 8 bita po pikselu, tada svaki piksel
može prikazati 28 = 256 različitih nijansi sive.

U praksi se često koristi i RGBA model boja koji koristi još dodatni alfa kanal
za određivanje prozirnosti boje. Za prikazivanje visokokvalitetnih fotografija i
digitalnih slika koristi se i 16, 24 ili 32 bita po komponenti. U ovome radu slike
su pohranjivane kao crno-bijele 8 bitne slike ako je slika sadržavala samo sive
tonove odnosno kao 8 bitne RGB slike ako je slika bila u boji.
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3. Metode za upravljanje
vizualnim značajkama digitalne
slike

U ovom poglavlju navedeni su alati za obradu slike u PhotoGrade-u i uspo-
redno s njima objašnjene su same metode obrade koje alati koriste. Kada se
odabere neki alat, u većini slučajeva se otvara dodatni prozor (slika 3.1) u ko-
jemu se dodatno namještaju parametri alata. Svaki takav prozor na dnu sadrži
gumbove: Reset, Apply i Cancel. Gumb Reset vraća parametre alata na njihove
inicijalne vrijednosti, gumb Apply primjenjuje trajno zadani alat na trenutnu sliku
(može se poništiti pomoću Undo) te gumb Cancel kojim se odustaje od zadane
promjene alatom.

Slika 3.1: Prozor za uglađivanje gamma korekcije

3.1. 2D transformacije

Prvo su navedeni alati koji vrše 2D transformacije nad slikama. U PhotoGrade-
u ti alati se nalaze u izborniku ‘Edit’.
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3.1.1. Promjena dimenzija

Ovom alatu se pristupa u izborniku Edit → Resize. Otvara se prozor (slika
3.2) u kojemu se mogu zadati nova širina i visina slike. Također, postoji opcija
Keep aspect ratio koja je inicijalno uključena te koja osigurava korisniku da će
nakon promjene dimenzija slike zadržati svoj izvorni omjer širine i visine što je u
većini slučajeva poželjno.

Slika 3.2: Alat za promjenu dimenzija slike

U nastavku je priložen izvorni kod funkcije (izvorni kod 3.1) koja mijenja
dimenzije slike. Promjena dimenzije vrši se OpenCV funkcijom resize. Za sma-
njivanje i povećanje slike koriste se različite interpolacije koje su implementirane
u OpenCV biblioteci te neće biti ovdje objašnjene.

1 public stat ic Mat r e s i z e (Mat mat , int width , int he ight ) {
2 int o r i g i n a l S i z e = mat . rows ( ) ∗ mat . c o l s ( ) ;
3 int newSize = width ∗ he ight ;
4
5 int i n t e r p o l a t i o n = newSize < o r i g i n a l S i z e ? Imgproc .

↪→ INTER_AREA : Imgproc .INTER_CUBIC;
6 Mat rmat = new Mat( height , width , mat . type ( ) ) ;
7 Imgproc . r e s i z e (mat , rmat , rmat . s i z e ( ) , 0 , 0 , i n t e r p o l a t i o n ) ;
8
9 return rmat ;
10 }

Izvorni kod 3.1: Promjena dimenzija slike

Na slikama 3.3 i 3.4 dan je primjer promjene dimenzija slike. Slika 3.3 pod a)
ima dimenzije 512×512 piksela nakon čega joj promijenimo dimenzije na 400×200
piksela. Slika 3.4 pod a) ima omjer širine i visine 1:1 te nakon promjene dimenzija
ima omjer 16:9.

9



(a) Prije (b) Poslije

Slika 3.3: Primjer promjene dimenzija slike

(a) Prije (b) Poslije

Slika 3.4: Primjer promjene dimenzija slike
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3.1.2. Odsijecanje

Ovom alatu se pristupa u izborniku Edit → Crop. Otvara se prozor u kojem
korisnik može odabrati koliko želi odrezati sliku s gornje, donje, lijeve i desne
strane slike.

(a) Prije (b) Poslije

Slika 3.5: Primjer odsijecanja slike

Ovo je postignuto tako da se uzme podmatrica koja je određena parametrima
xs i xe koji određuju početak i kraj slike po horizontalnoj osi te parametrima ys
i ye koji određuju početak i kraj slike po vertikalnoj osi. U nastavku je priložen
kod koji poziva OpenCV funkciju submat koja vrši gore navedeni postupak

1 public stat ic Mat cropImage (Mat mat , int xs , int ys , int xe , int ye )
2 {
3 Mat rez = mat . submat ( ys , ye , xs , xe ) ;
4 return r e z ;
5 }

Izvorni kod 3.2: Odsijecanje slike
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3.1.3. Zrcaljenje

Ovom alatu se pristupa u izborniku Edit→ Flip pa zatim odabir horizontalnog
ili vertikalnog zrcaljena. Ovaj efekt se postiže jednostavnom zamjenom simetrično
udaljenih piksela oko središnje horizontalne ili vertikalne osi slike.

(a) Izvorna slika (b) Horizontalno zrcaljenje (c) Vertikalno zrcaljenje

Slika 3.6: Primjer zrcaljenja slike

3.1.4. Zakretanje

Ovom alatu se pristupa u izborniku Edit → Rotate pa zatim odabir u smjeru
kazaljke na satu ili u smjeru obrnutome od kazaljke na satu. Slika 3.7 prikazuje
primjer zakretanja slike.

(a) Izvorna slika (b) Rotiranje za 90◦ u smjeru
kazaljke na satu

(c) Rotiranje za 90◦ u smjeru
suprotnome od kazaljke na
satu

Slika 3.7: Primjer rotiranja slike
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Opisat će se općeniti postupak rotacije u 2D prostoru [4]. Budući da se
rotacija općenito izvodi oko ishodišta koordinatnog sustava potrebno je osmisliti
način rotacije oko proizvoljne točke. U ovom slučaju sliku želimo rotirati oko
njezinog središta S = (Sx, Sy). U nastavku ćemo pretpostaviti da se nalazimo u
homogenom prostoru.

Prvi korak je translacija slike u ishodište koordinatnog sustava što ćemo učiniti
sljedećom matricom:

Ψ1 =


1 0 0
0 1 0
−Sx −Sy 1


Zatim se slika rotira oko ishodišta koordinatnog sustava za kut θ sljedećom ma-
tricom:

Ψ2 =


cos(θ) sin(θ) 0
−sin(θ) cos(θ) 0

0 0 1


Naposljetku sliku treba vratiti u točku S gdje se nalazila prije rotacije i translacije
što činimo inverzom matrice Ψ1:

Ψ3 = Ψ−1
1 =


1 0 0
0 1 0
Sx Sy 1


Ukupnu matricu transformacije Ψ dobivamo umnoškom sve tri matrice.

Ψ = Ψ1 ·Ψ2 ·Ψ3

Treba primijetiti da rotirana slika nema iste dimenzije kao izvorna. Štoviše, slika
koja je imala širinu w i visinu h, odnosno dimenzije w × h, sada ima dimenzije
h× w.

Da bi se dobila konačna rotirana slika svaki piksel treba transformirati ma-
tricom Ψ. Uzima se da se pojedini piksel nalazi u točki T =

[
Tx Ty 1

]
, a

zatim se za svaki piksel vrši transformacija T ′ = T ·Ψ =
[
T ′x T ′y 1

]
nakon čega

se ponovno natrag iz homogenog prostora točka T ′ vraća u radni prostor te se
dobiva krajnja pozicija rotiranog piksela na poziciji Tr = (T ′x, T ′y)
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3.2. Upravljanje luminancijom

3.2.1. LUT

Za upravljanje luminancijom korišten je LUT (lookup table) koji je zapravo
tablica preslikavanja vrijednosti. U slučaju digitalne slike, vrijednosti koje se
preslikavaju su vrijednosti pojedinih piksela. Uzima se da je v vrijednost pojedi-
nog piksela za koji vrijedi v ∈ [0, 255] budući da se radi o 8-bitnim slikama. LUT
se definira kao preslikavanje:

v′ = L(v) (3.1)

Gdje je v′ nova vrijednost piksela, a L(v) bilo koja kontinuirana funkcija na
intervalu [0, 255]. Naravno, ako vrijednost L(v) izađe iz intervala [0, 255] onda
vrijedi:

v′ =


0 ako L(v) < 0

255 ako L(v) > 255
(3.2)

Dodatno, ako L(v) nije cijeli broj uzima se najveće cijelo dobivene vrijednosti:

v′ = dL(v)e (3.3)

Naravno, navedeno preslikavanje izvodi se za svaki piksel u slici.

3.2.2. Linearno upravljanje svjetlinom i kontrastom

Pojmovi svjetline i kontrasta objasnit će se pod pretpostavkom da su pikseli 8-
bitni te da su sivi tonovi (engl. grayscale). Što je vrijednost piksela veća, to je on
svjetliji, odnosno piksel v1 = 200 je svjetliji od piksela v2 = 100. Pojam kontrasta
se može definirati kao razlika svjetlina dvaju piksela. Što je razlika veća, to je
kontrast veći. Dakle, kontrast se definira kao c = | v1 − v2 |. Sada su neprecizno
definirani pojmovi svjetlije i kontrastnije slike budući da nije potrebna gruba
definicija, već je dovoljna intuicija. Slika je svjetlija što ima veći broj svjetlijih
piksela, a kontrastnija je što ima veću razliku između sjena i svjetlijih tonova.

Alatu za linearno upravljanje svjetlinom i kontrastom pristupa se izbornikom
Luma → Linear Brightness & Contrast nakon čega će se pojaviti prozor na ko-
jemu se nalaze dva klizača (engl. sliders) pomoću kojih se namještaju parametri
linearnog upravljanja svjetline i kontrasta slike.
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(a) Izvorna slika (b) α > 1 (c) α < 1

(d) Histogram od a) (e) Histogram od b) (f) Histogram od c)

Slika 3.8: Manipulacija kontrasta linearnim upravljanjem kontrastom

Linearno upravljanje svjetlinom i kontrastom ostvareno je kao LUT [5]:

L(α, β, v) = αv + β (3.4)

gdje je α faktor povećanja kontrasta, a β pomak svjetline. Uvijek vrijedi α > 0.
Za α > 1 kontrast se povećava, a za α < 1 kontrast se smanjuje. Analizira se
slika 3.8 kako bi se na primjeru razumjelo što se događa sa slikom. Vidi se kako
su vrijednosti na izvornoj slici centrirane i ravnomjerno raspoređene oko sred-
njih tonova. Kada povećavamo kontrast (vidi primjer b), vrijednosti se linearno
udaljavaju od vrijednosti nula, suprotno tome kada smanjujemo kontrast (vidi
primjer c), vrijednosti se linearno približavaju vrijednosti nula. Ovom metodom
kontrast utječe i na svjetlinu slike. Subjektivnom procjenom ovo ne daje idealne
rezultate koje bismo očekivali od povećanja kontrasta, stoga se u idućem odjeljku
razmatra bolja metoda.

Kada je β > 0 onda se svjetlina povećava, kada je β < 0 svjetlina se smanjuje.
Na slici 3.9 je analiziran utjecaj pomaka β. Koristi se ista slika kao u prošlom
razmatranju. U slučaju kada povećavamo svjetlinu (vidi slučaj b), to se na his-
togramu odražava kao linearni pomak u desno, dok u slučaju kada smanjujemo
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svjetlost (vidi slučaj c) vrijednosti se pomiču linearno u lijevo. Sa subjektivne
strane rezultat nije loš, ali postoje slučajevi kada će rezultat izgledati vrlo ne-
prirodno. Funkcija koja bi bila idealna bi bila ona koja bi najviše utjecala na
srednje tonove, a manje na sjene i svijetle tonove. Takva metoda će se razmotriti
u sljedećem odjeljku.

(a) Izvorna slika (b) β > 0 (c) β < 0

(d) Histogram od a) (e) Histogram od b) (f) Histogram od c)

Slika 3.9: Manipulacija svjetline linearnim upravljanjem svjetlinom

16



3.2.3. Upravljanje svjetlinom i kontrastom kubičnim splajn
krivuljama

Splajn krivulje su glatke polinomne krivulje definirane po dijelovima [6]. Jedna
od njih je kubična splajn krivulja. Takva krivulja ima dijelove definirane izrazom:

Pi(t) = ai + bi(t− xi) + ci(t− xi)2 + di(t− xi)3 (3.5)

Za danih n + 1 koordinata (x0, y0), ..., (xn, yn), pronalazi se n, P0 i Pk, koji
zadovoljavaju za 1 ≤ k ≤ n− 1:

P0(x0) = y0 (3.6)

Pk−1(xk) = yk = Pk(xk) (3.7)

P ′k−1(xk) = P ′k(xk) (3.8)

P ′′k−1(xk) = P ′′k (xk) (3.9)

P ′′0 = P ′′xn = 0 (3.10)

Kubične splajn krivulje najčešće se nalaze kubičnim splajn interpolatorima.
U sklopu projekta je korišten paket Math iz Apache Commons 1 koji sadrži ku-
bični splajn interpolator. Navedene krivulje su korištene kao LUT-ovi kako bi se
postigla bolja kontrola kod upravljanja svjetlinom i kontrastom.

Za upravljanje kontrastom korišten je LUT koji je ovisno o parametru α ku-
bična splajn krivulja ili pravac koji prolazi kroz zadane točke. Za α > 0, LUT
jest kubična splajn krivulja koja redom prolazi kroz točke (xi, yi) za i ∈ [1, 5]:

(0, 0), (64 + α, 64− α), (127, 127), (191− α, 191 + α), (255, 255)

Odnosno za α < 0, točke se interpoliraju linearnom interpolacijom, tj. LUT jest
pravac koji prolazi kroz točke:

(0, 0− α), (255, 255 + α)

Ovako definirani LUT upravljanja kontrastom uzima se kao L1(α, v). Graf
koji zornije prikazuje krivulje od L1(α, v) prikazan je na slici 3.10.

LUT koji upravlja svjetlinom jest kubična splajn krivulja koja ovisi o para-
metru β te koja redom prolazi kroz točke:

(0, 0), (127− β, 127 + β), (255, 255)
1Skupina biblioteka za programski jezik Java
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(a) α > 0 (b) α < 0

Slika 3.10: Grafovi koji prikazuju LUT upravljanja kontrastom

Tako definiran LUT uzima se kao L2(β, v) te je zornije prikazan na slici 3.11.
Konačno, LUT koji upravlja svjetlinom i kontrastom kubičnim splajn krivuljama
jest:

L(α, β, v) = L2(β, L1(α, v)) (3.11)

Slika 3.11: Graf koji prikazuje LUT upravljanja svjetlinom

Alatu za navedeno upravljanje kontrastom i svjetlinom pristupa se izbornikom
File → Smart Brightness & Contrast nakon čega se pojavi identičan prozor za
namještanje parametara α i β kao kod linearnog upravljanja svjetlinom i kontras-
tom (slika 3.13). Na slici 3.12 vidi se da se povećanjem kontrasta (vidi primjer
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(a) Izvorna slika (b) α > 0 (c) α < 0

(d) Histogram od a) (e) Histogram od b) (f) Histogram od c)

Slika 3.12: Upravljanje kontrastom LUT-om L1

b) vrijednosti na histogramu razmiču od središta x = 127, nasuprot smanjivanju
kontrasta (vidi primjer c) kada se vrijednosti na histogramu skupljaju oko sredi-
šta. Ovime je postignuto prirodnije upravljanje kontrastom za razliku od linearne
metode te dodatno, promjena kontrasta više ne utječe toliko na svjetlinu slike.

Slika 3.13: Korištenje alata Smart Brightness & Contrast

Na slici 3.14 analizira se povećanje i smanjenje svjetline navedenom meto-
dom. Iz danih histograma vidi se da se vrijednosti sivih tonova primiču sjenama
odnosno svijetlim tonovima ovisno o parametru β.
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(a) Izvorna slika (b) β > 0 (c) β < 0

(d) Histogram od a) (e) Histogram od b) (f) Histogram od c)

Slika 3.14: Upravljanje svjetlinom LUT-om L2

3.2.4. Upravljanje sjenama, srednjim i svijetlim tonovima

Ovome alatu pristupa se izbornikom Luma → Shadows & Highlights nakon
čega se otvara prozor s tri klizača (engl. sliders) pomoću kojih se upravlja sje-
nama, srednjim i svijetlim tonovima. Princip je sličan onome kod upravljanja
svjetlinom pomoću kubičnih splajn krivulja. Naime, kod ove metode svaki pa-
rametar kontrolira svjetlinu jednog raspona luminancije. Budući da se radi o
8-bitnim slikama i vrijednostima u rasponu [0, 255], taj raspon je podijeljen na
tri jednaka dijela: sjene u rasponu [0, 85), srednji tonovi u rasponu [85, 170) te
svijetli tonovi u rasponu od [170, 255]. Na temelju tih raspona definira se LUT
koji je kubična splajn krivulja te ovisi tri parametra α, β i γ koji upravljaju
sjenama, srednjim i svijetlim tonovima respektivno te redom prolazi kroz točke:

(0, 0), (42− α, 42 + α), (85,85), (127− β, 127 + β),

(170, 170), (212− γ,212 + γ), (255, 255)

Slika 3.15 zornije prikazuje kako LUT upravlja luminancijom. Na slici 3.16
je primjer upravljanja sjenama. Vidi se kako parametar α povećava i smanjuje
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Slika 3.15: Krivulje LUT-a koje upravljaju sjenama, srednjim i svijetlim tonovima

svjetlinu samo dijelovima slike koji se na histogramu nalaze u donjoj trećini, u
ovom slučaju to je većinski drveće na donjem dijelu slike.

(a) Izvorna slika (b) α < 0 (c) α > 0

(d) Histogram od a) (e) Histogram od b) (f) Histogram od c)

Slika 3.16: Primjeri upravljanja sjenama

Analogno vrijedi i za primjer na slici 3.17 gdje se upravlja srednjim i svijetlim
tonovima. Srednji tonovi na ovom primjeru pripadaju planinama na vertikalnoj
sredini slike te je prikazano kako promjena parametra β utječe samo na njih.
Promjena svijetlih tonova odnosno parametra γ utječe samo na nebo pri vrhu
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slike.

(a) Izvorna slika (b) β < 0 (c) β > 0

(d) Histogram od a) (e) Histogram od b) (f) Histogram od c)

(g) γ < 0 (h) γ > 0

(i) Histogram od g) (j) Histogram od g)

Slika 3.17: Primjeri upravljanja srednjim i svijetlim tonovima
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3.2.5. Upravljanje razinama

Razine se definiraju pomoću parametara d, g koji su u rasponu [0, 255]. Sve
vrijednosti manje od g pretvore se u crne piksele te sve vrijednosti koje su veće od
g pretvore se u bijele piksele. Uzet je pristup koji će sačuvati prirodnu strukturu
slike. Definira se LUT (slika 3.18):

L(v) = 255
g − d

v − 255
g − d

d (3.12)

Alatu za upravljanje razinama se pristupa izbornikom Luma → Levels. Primjer
korištenja alata se nalazi na slici 3.19

Slika 3.18: Graf LUT-a koji upravlja razinama

(a) Prije (b) Poslije

Slika 3.19: Primjer upravljanja razinama
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3.2.6. Gamma korekcija

Gamma korekcija jest primjenjivanje nelinearnog LUT-a (slika 3.20) na vri-
jednosti čime se postiže nelinearno povećanje ili smanjenje svjetline što je u nekim
slučajevima prirodnija transformacija za razliku od linearne [5]. Ovome alatu se
pristupa izbornikom Luma → Gamma Correction. Gamma korekcija definira se
kao LUT koji ovisi o parametru γ:

L(γ, v) =
(
v

255

)γ
· 255 (3.13)

Slika 3.20: Graf za različite γ vrijednosti

Slika 3.21 prikazuje primjer posvjetljivanja tamne slike gamma korekcijom s
parametrom γ = 0.4

Slika 3.21: Primjer povećanja svjetline gamma korekcijom
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3.3. Upravljanje zasićenjem i tonom boje

U prošlom potpoglavlju su razmotrene metode obrade digitalne fotografije
pomoću kojih se upravlja luminancijom. U ovom poglavlju su razmotrene metode
upravljanja zasićenjem i tonom boje.

3.3.1. Alat HSV

Ovome alatu se pristupa izbornikom Color → HSV nakon čega se prikazuje
prozor s tri klizača (engl. sliders) pomoću kojih se namještaju parametri. Alat
HSV stvara linearni pomak u svakom od kanala HSV modela na cijeloj slici.
Alat HSV ima tri parametra ∆h, ∆s i ∆v koji određuju pomak u svakom od
kanala HSV modela na cijeloj slici. Dakle, za svaki piksel na slici koji ima trojku
vrijednosti vHSV = (h, s, v) gdje su h, s i v kut nijanse, saturacija i vrijednost
iz HSV modela respektivno, definira se pomak ∆vHSV = (∆h,∆s,∆v) pomoću
kojega se definiraju nove vrijednosti piksela prema izrazu:

v′HSV = vHSV + ∆vHSV = (h+ ∆h, s+ ∆s, v + ∆v) (3.14)

gdje je v′HSV nova trojka piksela. Ovaj postupak se provodi za svaki piksel na
slici.

Na slici 3.22 prikazan je primjer upravljanja nijansom boje alatom HSV. Na
histogramu se očituje kao redistribucija svakog kanala boja. Također, vidi se pik-
selizacija prijelaza boja na slici b) što jest nedostatak ovo postupka. Nadalje, na
istoj slici 3.22 je prikazano i upravljanje saturacijom boje. Smanjivanje saturacije
na histogramu se očituje kao približavanje kanala dominantnom kanalu (u ovom
slučaju je to kanal crvene boje), a povećanje saturacije ima suprotan učinak na
kanale.

Djelovanje parametra ∆v se neće posebno analizirati zato što ima identičan
utjecaj na sliku kao metoda linearnog upravljanja svjetlinom koja je razmotrena
u prošlom potpoglavlju.
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(a) Orginalna slika (b) ∆h > 0

(c) Histogram od a) (d) Histogram od b)

(e) ∆s < 0 (f) ∆s > 0

(g) Histogram od e) (h) Histogram od f)

Slika 3.22: Upravljanje nijansom i saturacijom boje
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3.3.2. Bojanje slike u zadanu boju

Ovome alatu pristupa se izbornikom Color→ Tint nakon čega se otvara prozor
u kojemu korisnik odabire boju (slika 3.23). Nakon odabrane boje, uzimaju se vri-
jednosti ht, st koje predstavljaju kut nijanse i saturaciju boje iz HSV modela res-
pektivno. Tada, za svaki piksel slike, koji ima trojku vrijednosti vHSV = (h, s, v)
gdje su h, s i v kut nijanse, saturacija i vrijednost iz HSV modela respektivno,
definira se transformacija:

v′HSV = (ht, st, v) (3.15)

gdje je v′HSV nova trojka piksela. Dakle, za svaki piksel se postavlja nijansa boje i
saturacija od boje koju je korisnik odabrao. Na slici 3.24 se nalazi primjer bojanja
slike u ljubičastu nijansu.

Slika 3.23: Odabir boje

Slika 3.24: Primjer bojanja slike
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3.3.3. Pretvorba u sive tonove

Ovdje se razmatra pretvorba slike u boji u crno-bijelu sliku (engl. grayscale).
Alatu za pretvorbu u crno-bijelu sliku se pristupa izbornikom Color → to Grays-
cale. Pri pretvorbi RGB piksela u crno-bijeli piksel važno je zadržati luminantnu
vrijednost piksela [7]. Za svaki model boje to se radi na drugačiji način ovisno
o zastupljenosti boja po kanalima. Budući da se ovdje radi pretvorba iz RGB
modela pomoću biblioteke OpenCV, određivanje približne luminantne vrijednosti
piksela Y ′ dan je izrazom [3]:

Y ′ = 0.229 ·R + 0.587 ·G+ 0.114 ·B (3.16)

gdje su R, G i B vrijednosti crvene, zelene i plave boje iz RGB modela.

(a) Prije (b) Poslije

(c) Histogram od a) (d) Histogram od b)

Slika 3.25: Primjer pretvorbe slike u boji u crno-bijelu sliku

Na slici 3.25 je dan primjer pretvorbe. Histogrami od slika a) i b) su identični.
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3.4. Filteri

U ovom poglavlju razmotrena je uporaba filtera na digitalne fotografije kroz
alat PhotoGrade. Filteri se obično koriste za povećavanje i smanjivanje šuma. U
alatu PhotoGrade implementirane su metode filtriranja koje rezultiraju u izoš-
travanju slike ili zamućenju slike.

3.4.1. Zamućenje

Za postizanje efekta zamućenja korištena je metoda Gaussovog uglađivanja
(engl. Gaussian blur). Tipično se koristi za smanjenje šuma ili detalja u sli-
kama [2]. Metoda se zasniva na primjeni funkcije Gaussove distribucije na sliku.
Gaussova distribucija u 2D prostoru dana je izrazom:

G(x, y) = 1√
2πσ2

e−
x2+y2

2σ2 (3.17)

gdje su x i y udaljenosti po apscisi i ordinati, a σ standardna devijacija Gaussove
distribucije. Na temelju vrijednosti distribucije konstruira se kvadratna matrica
reda 2n− 1, gdje je n ∈ N0, koja predstavlja jezgru (engl. kernel) za konvoluciju
sa slikom. 2D konvolucija se provodi tako da se središte jezgrene matrice poravna
s elementom nad kojim se provodi transformacija. Poravnate vrijednosti iz jezgre
i elementi iz niza se pomnože te međusobno sumiraju. Rezultat je konvolucija
za element nad kojim se provodi transformacija. Takav postupak se provodi za
svaki element u dvodimenzionalnom nizu, odnosno za svaki piksel na slici. Primjer
jezgrene matrice reda 5 za Gaussovo uglađivanje [8]:

1
256 ·



1 4 6 4 1
4 16 24 16 4
6 24 36 24 6
4 16 24 16 4
1 4 6 4 1


(3.18)

Gaussovo uglađivanje djeluje kao niskopropusni filtar što je vidljivo na FFT grafo-
vima (slika 3.26) koji prikazuju prirodni logaritam modula frekvencija Fourierove
transformacije.

Alatu za zamućivanje slike u PhotoGrade-u pristupa se izbornikom Filter →
Blur nakon čega se otvara prozor u kojemu se pomoću klizača (engl. slider) na-
mješta red Gaussove jezgrene matrice.
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(a) Izvorna slika (b) Jezgra reda 9 (c) Jezgra reda 29

(d) FFT graf od a) (e) FFT graf od b) (f) FFT graf od c)

Slika 3.26: Primjer zamućivanja slike metodom Gaussovog uglađivanja

3.4.2. Izoštravanje

Za izoštravanje slike korištena je metoda unsharp mask čiji se princip nadove-
zuje na metodu Gaussovim uglađivanjem. Slika koju izoštravamo reprezentirana
je matricom O i uglađena Gaussovom metodom čiji je rezultat označen matricom
B. Slika dobivena metodom unsharp mask reprezentirana matricom U izvedena
je izrazom [9]:

U = O + α · (O −B) (3.19)

gdje je α koeficijent koji označava jačinu izoštravanja. Vrijedi α > 0, α ∈ R.
Na ovaj način se postiglo pojačavanje srednjih i visokih frekvencija. Naime, O u
prosjeku sadržava najviše srednjih frekvencija dok B sadržava niske frekvencije.
Njihovom razlikom O − B dobivamo srednje i visoke frekvencije koje su poja-
čane koeficijentom α. Zatim na izvornu sliku dodajemo ovako dobivenu razliku.
Budući da metoda unsharp mask pojačava visoke frekvencije rezultat će biti i
povećanje šuma u slici.

U PhotoGrade-u unsharp mask alat pokreće se izbornikom Filter → Shar-
pen nakon čega se otvara prozor s dva klizača (engl. slider) pomoću kojih se
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namještaju parametri α te red jezgre Gaussovog uglađivanja.
Slika 3.27 prikazuje primjer izoštravanja slike. FFT grafovi ukazuju da je

metoda unsharp mask visokopropusni filtar. Djelovanje izoštravanja jasno se vidi
na detaljima kuće.

(a) Prije (b) Poslije

(c) FFT graf od a) (d) FFT graf od b)

Slika 3.27: Primjer izoštravanja slike metodom unsharp mask
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3.5. Efekti

Efekti su alati pomoću kojih korisnik jednostavno može urediti sliku. Photo-
Grade implementira nekoliko efekata koji su navedeni i objašnjeni u ovom potpo-
glavlju. Svi efekti u alatu PhotoGrade nalaze se u izborniku ‘Effects’ (slika 3.28).

Slika 3.28: izbornik ‘Effects’

3.5.1. Sepia

Sepia je efekt koji je rasprostranjen u alatima za obradu slika. Radi se o
metodi koja sliku oboja u crvenkastosmeđu boju te joj tako daje izgled starenja
kod starih fotografija ili izgled starijih fotografija koje su kemijski tretirane zbog
vizualnih efekata ili u svrhu arhiviranja [10].

Sliku se boja u sepia ton pomoću transformacijske matrice koja se množi sa
svakim pikselom V =

[
B G R

]T
, gdje su B, G i R vrijednosti plave, zelene i

crvene nijanse po RGB modelu. Transformacijska matrica dana je izrazom [11]:

T sepia =


0.272 0.534 0.131
0.349 0.686 0.168
0.393 0.769 0.189

 (3.20)

Sepia efektu se pristupa izbornikom Effects → Sepia.
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(a) Prije (b) Poslije

(c) Histogram od a) (d) Histogram od b)

Slika 3.29: Primjer sepia efekta

3.5.2. Invertiranje

Invertiranje je postupak kojim se dobiva efekt fotografija razvijenih iz nega-
tivnog filma. Postupak invertiranja slike provodi se tako da se svaki element slike
ve, bila to komponenta boje ako je slika u boji ili vrijednost piksela ako se radi o
crno-bijeloj slici (engl. grayscale), invertira pomoću izraza:

v′e = 255− ve (3.21)

gdje je v′e nova vrijednost elementa slike. Pretpostavlja se da su slike 8-bitne pa
se zato oduzima od broja 28 − 1 = 255.

Na slici 3.30 nalazi se primjer invertiranja slike. Na histogramu invertirane
slike očituje se zrcaljenje oko vertikalnog središta histograma.
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(a) Prije (b) Poslije

(c) Histogram od a) (d) Histogram od b)

Slika 3.30: Invertiranje slike

3.5.3. Deep blue

Deep blue je efekt koji kombinira efekt sepia i efekt invertiranja. Rezultat jest
bojanje slike u tamno plavu boju (slika 3.31). Deep blue efekt se postiže tako da
sliku prvo invertiramo, zatim na takvu invertiranu sliku primijenimo sepia efekt
te konačno dobivenu sliku još jednom invertiramo. Efektu deep blue pristupa se
izbornikom Effects → Deep blue.

Slika 3.31: Primjer efekta deep blue
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4. Programsko rješenje
aplikacije PhotoGrade

Postoje mnogi alati i aplikacije koji pružaju mogućnost manipulacije slikovnim
elementima na neki način. Matlab kao programski jezik sadrži nekoliko paketa
s funkcijama koje programeru omogućavaju razne načine obrade slika. Također,
programski jezici poput pythona su popularan izbor zbog velikog broja, koji i dalje
raste, raznih biblioteka koje programerima omogućavaju široku paletu načina
obrade i manipulacije slikama.

S druge strane, postoji potreba za gotovim programskim rješenjima koji nude
mogućnosti obrade slika bez znanja programiranja. Dizajneri, fotografi, digitalni
umjetnici pa čak i obični korisnici imaju potrebu za stvaranjem digitalnog slikov-
nog sadržaja ili oblikovanjem, dorađivanjem i manipulacijom već gotovih digital-
nih slika dobivenih iz digitalnih fotoaparata ili pametnih telefona. Dakle, potreba
za aplikacijama koje nude mogućnosti uređivanje slika postoji za profesionalce i
obične korisnike.

Danas postoje mnoge aplikacije koje pružaju navedene mogućnosti. Jedne
od najpopularnijih su Photoshop i Gimp koje pružaju sveobuhvatne mogućnosti
stvaranja novog slikovnog sadržaja ili obrađivanja postojećeg. Usporedno s njima,
postoje aplikacije koje pružaju specifičnije funkcionalnosti koje su usmjerene samo
na obradu digitalnih fotografija. Jedna takva aplikacije jest Lightroom za koju
bi se moglo reći da je „mlađa sestra“ od aplikacije Photoshop jer ih je proizvela
ista tvrtka Adobe.

Glavna svrha alata PhotoGrade jest pružiti korisniku jednostavan i intuitivan
način za obradu fotografija. Iako alat nudi funkcionalnosti za tehničko poboljša-
nje fotografije, glavna namjena mu je obrada fotografije iz umjetničkih razloga.
Korisnik kombiniranjem raznih alata unutar PhotoGrade-a može postići željeni
rezultat. PhotoGrade je softversko rješenje napisano u programskom jeziku Java
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uz pomoć biblioteke OpenCV1 koja je korištena za izravnu manipulaciju slikov-
nim elementima. U sljedeća dva poglavlja objasnit će se sve funkcionalnost alata
PhotoGrade.

4.1. Zahtjevi aplikacije

Načela oblikovanja programske potrebe nalažu da razvoj treba započeti s de-
finiranjem funkcionalnih i nefunkcionalnih zahtjeva aplikacije. Funkcionalni zah-
tjevi opisuju kakve mogućnosti aplikacija pruža odnosno što sve može napraviti.
S druge strane, nefunkcionalni zahtjevi opisuju kakva treba biti kvaliteta izvrša-
vanja funkcionalnih zahtjeva.

4.1.1. Funkcionalni zahtjevi

U ovom odjeljku definirat će se funkcionalni zahtjevi aplikacije PhotoGrade
koji bi trebali predstavljati minimalne funkcionalne zahtjeve svake aplikacije za
obradu fotografija.

1. Učitavanje slika raznih formata pohranjenih u stalnoj memoriji

2. Pregled učitane slike neovisan o rezoluciji fotografije

3. Prikazivanje histograma slike

(a) Luminantna komponenta

(b) Svaki kanal boje zasebno

4. 2D transformacije nad slikom

(a) Promjena veličine (engl. resize)

(b) Odsijecanje (engl. crop)

(c) Rotacija slike za 90◦ u oba smjera

(d) Zrcaljenje – vertikalno i horizontalno (engl. flip)

5. Upravljanje luminantnom komponentom slike

(a) Linearno upravljanje svjetlinom i kontrastom
1OpenCV (Open Source Computer Vision Library) jest biblioteka za računalni vid i strojno

učenje.
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(b) Upravljanje svjetlinom i kontrastom pomoću kubičnih splajn krivulja

(c) Odvojeno upravljanje svjetlinom na različitim luminantnim rasponima

i. Sjene

ii. Srednji tonovi

iii. Svijetli tonovi

(d) Upravljanje cjelokupnim luminantnim rasponom

(e) Gama korekcija

6. Upravljanje zasićenjem i tonom boje

(a) Linearna promjena HSV komponenata na cijeloj slici

(b) Bojanje slike u zadanu boju (engl. tint)

(c) Pretvorba slike u sive tonove, također se zove pretvorba u crno-bijelu
sliku (engl. grayscale)

7. Primjena filtera

(a) Izoštravanje slike metodom unsharp mask

(b) Zamućenje slike metodom gaussian blur

8. Primjena unaprijed definiranih efekata

(a) Sepia efekt

(b) Deep blue efekt

(c) Inverzija slike (engl. invert)

9. Kretanje kroz povijest obrade fotografije

(a) Poništi promjene (engl. undo)

(b) Ponovi poništeno (engl. redo)

10. Usporedba izvorno učitane fotografije i obrađene fotografije

11. Prikaz promjena koje korisnik nad slikom u stvarnom vremenu

12. Pohrana uređenih slika u stalnu memoriju

13. Grafičko sučelje
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Kao što je vidljivo iz navedenih funkcionalnih zahtjeva, oni su brojni čak i
kod jednog skupa koji predstavlja minimalan oblik zahtjeva. U suštini, svaka
aplikacija za obradu slike treba moću učitati sliku, obraditi je na neki način
te pohraniti promijene. Dodatno, poželjan je zahtjev obrade slika u stvarnom
vremenu tako da korisnici mogu odmah doživjeti promjene koje su napravili te
im omogućiti veću slobodu i kreativnost pri uređivanju.

4.1.2. Nefunkcionalni zahtjevi

Nefunkcionalni zahtjevi navedeni u ovom odjeljku predstavljati će idealan skup
nefunkcionalnih zahtjeva aplikacije PhotoGrade. Općenito programska rješenja
imaju zadane idealne nefunkcionalne zahtjeve koje je u praksi često realizirati.
Tako ni aplikacija PhotoGrade ne ispunjava ove zahtjeve u njihovoj potpunosti
ili ih uopće ne ispunjava.

1. Učitavanje slika svih formata i rezolucija u trajanju kraćem od jedne se-
kunde

2. Aplikacija se niti u jednom trenutku ne smije srušiti usprkos korisnikovim
radnjama

3. Prikaz promjena u stvarnom bez trzanja i zastajkivanja (engl. lagging)

4.2. Pomoćni alati u aplikaciji Photograde

U sklopu PhotoGrade-a nalaze se pomoćni alati koji pomažu i olakšavaju
korisniku praćenje promjena koje je napravio odnosno objektivnije analiziranje
slike koju uređuje. Prvi takav alat omogućuje korisniku usporedbu između izvorno
učitane slike i trenutne slike koju je uredio. Ide se na izbornik Analyze→ Toggle
original/edited image nakon čega će se prikazati izvorna slika koju je korisnik
učitao. Ponovnim odabirom navedenog alata se vraća trenutno uređena slika od
korisnika.

Sljedeći alat jest histogram koji prikazuje frekvencije luminantne komponente
slike. Histogram jest općenito graf koji pobrojava frekvencije zadanih raspona
vrijednosti. U slučaju 8-bitne slike, histogram pobrojava vrijednosti iz raspona
0 – 255. Vizualno, histogram s lijeve strane prikazuje koliko sjena ima slika,
s desne strane prikazuje koliko ima svijetlih tonova te u sredini prikazuje koliko
srednjih tonova sadrži slika. Kako bi korisnik mogao vidjeti histogram luminantne
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komponente (slika 4.1) slike koju uređuje ide na izbornik Analyze → Luminance
Histogram.

Slika 4.1: Primjer histograma koji prikazuje luminantnu komponentu

Usporedno s histogramom luminantne komponente, PhotoGrade ima i his-
togram koji prikazuje svaki kanal zasebno. Kako bi korisnik mogao vidjeti his-
togram svakog kanala (slika 4.2) slike koju uređuje ide na izbornik Analyze →
RGB Histogram. Ako korisnik trenutno radi s crno-bijelom slikom (engl. grays-
cale), navedeni histogram će jednostavno prikazati luminantnu komponentu slike.

Slika 4.2: Primjer histograma koji prikazuje svaki kanal zasebno

4.3. Alati za razvoj aplikacije

U ovom poglavlju razmotrit će se razni alati i načini na koji se može razviti
programsko rješenje za uređivanje slika. Nadalje, demonstrirat će se razvoj apli-
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kacije PhotoGrade kao jedan konkretan primjer razvoja aplikacije za uređivanje
slika.

Pri razvoju bilo kojeg programskog rješenja treba se odlučiti o izboru pro-
gramskog jezika u kojem će aplikacija biti razvijena. U uvodu je naveden matlab
kao izbor programskog jezika u kojemu se mogu obrađivati slike. Iako matlab
sadržava mnoge funkcije za obradu slika, ipak ne nudi dovoljne funkcionalnosti
za razvoj samostalne aplikacije koju će korisnici moći pokrenuti na neovisnom
operacijskom sustavu. Matlab ne nudi funkcionalnosti izrade grafičkog sučelja
koje je preko potrebno za ovakvu vrstu aplikacije. Nadalje, matlab je interpre-
tirani jezik što automatski postavlja usko grlo za daljnje optimizacije aplikacije
koje bi bile potrebne za što bolje ispunjenje nefunkcionalnih zahtjeva.

Nadalje, izbor programskog jezika također ovisi o tome hoće li se manipulacija
slikovnim elementima vršiti preko neke od biblioteka ili će se metode obrade slike
programirati „iz nule”. Potonje se preporuča jedino u slučaju kada velike tvrtke
rade na velikom projektu i trebaju imati potpunu kontrolu nad funkcionalnošću
i kodom. Dakle, preporučeno bi bilo koristiti neku od gotovih biblioteka. Razne
biblioteke pružaju različitu fleksibilnost i mogućnosti pri manipulaciji slikovnim
elementima.

Također, izbor programskog jezika ovisi o sustavu ili sustavima na kojima
će se aplikacija izvršavati te načinu izvedbe grafičkog sučelja. Operativni sus-
tavi Windows i OS X imaju mogućnost nativnog razvoja grafičkog sučelja, dok
se za Linux sustave koriste specifikacije poput X Windows System ili Wayland.
Dodatno, razvoj aplikacija za pametne telefone donosi sasvim drugačiji pristup
izradi cjelokupne aplikacije pa tako i cijelog grafičkog sučelja. Usprkos različi-
tim sustavima, postoje biblioteke koje nude podršku za razvoj grafičkih sučelja
na više sustava odjednom. Neki programski jezici koji su razvijeni u svrhu više-
sistemske podrške nude u svojim standardnim bibliotekama podršku za razvoj
više-sistemskih grafičkih sučelja. Npr. programski jezik Java sa svojim bibliote-
kama Swing i JavaFX te programski jezik C# s bibliotekama Mono i GTK#.

Iz svega navedenog vidljivo je da izbor programskog jezika, biblioteke za
obradu slikovnih elemenata te izbor biblioteke za izradu grafičkog sučelja ovisi
o puno parametara te za sobom povlači razna ograničenja. Aplikacija Photo-
Grade napravljena je u programskom jeziku Java. Korištena je biblioteka Swing
za izradu grafičkog sučelja te ekstenzija biblioteke OpenCV za manipulaciju sli-
kovnim elementima. Ovakav izbor pruža više-sistemsku podršku te koristi visoko
fleksibilnu biblioteku za manipulaciju slikovnim elementima. Tablica 4.1 prika-
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zuje razne biblioteke za razvoj grafičkog sučelja i manipulaciju slikovnih elemenata
za nekoliko odabranih programskih jezika.

Tablica 4.1: Programski jezici i biblioteke

Programski
jezik

Biblioteke za
manipulaciju slikovnim

elementima

Biblioteke za
izradu grafičkog

sučelja

Python

Scikit-image Kivy
OpenCV WxPython
Mahotas libavg
SimpleTK Pyglet
SciPy PyGtk
Pillow PyQt
Matplotlib

Java

OpenCV Swing
BoofCV JavaFX
Deeplearning4j SWT
JavaCV Apache Pivot
AlgART

C++

OpenCV Qt
dlib GTK+
ITK wxWidgets
OTB JUCE

4.3.1. CUDA i OpenCL

Obrada slike u stvarnom vremenu jest računalno zahtjevno te je potrebno izvo-
đenje slikovnih operacija prebaciti na grafičku karticu (engl. Graphical processing
unit – GPU ). Današnji relevantni standardi za opće-namjensko procesiranje na
grafičkim karticama su CUDA i OpenCL. Slučaj u kojem se razmatra programi-
ranje obrada slika „iz nule” podrazumijeva da bi se operacije nad slikama trebale
implementirati pomoću navedenih standarda. CUDA je programsko sučelje koju
je razvila tvrtka Nvida za svoje grafičke kartice. OpenCL je otvoreni standard
kojeg održava neprofitna organizacija Khronos Group. Oba standarda su široko
korištena ovisno o namijeni.
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Prednost koje grafičke kartice imaju za razliku od običnih procesora (engl. Cen-
tral processing unit - CPU ) jest paralelno izvođenje mnogih jednostavnih opera-
cija odjednom. Kod običnih procesora, izvršavanje operacija je sekvencijalno.
Dakako, obični procesori mogu izvršavati puno kompleksnije operacije od gra-
fičkih kartica. Prva namjena grafičkih kartica bila je prikazivanje kompleksnijih
3D grafičkih elemenata. Naime, procesiranje i vizualizirane grafičkih elemenata
zahtijeva izvršavanje puno jednostavnih paralelnih operacija. Dodatni razvoj teh-
nologije doveo je do uviđanja potencijala grafičkih kartica kao opće-namjenskih
jedinica za paralelno procesiranje te su tako nastali standardi CUDA i OpenCL.
Kako su digitalne slike nakupina mnogo jednostavnih slikovnih elemenata koje
treba paralelno obradi, tako je njihova obrada na grafičkim karticama logičan
izbor.

Navedeni standardi se danas široko primjenjuju u područjima obrade videa i
slike, računalnom vidu, neuronskim mrežama te u raznim zadacima kojima po-
goduje paralelno izvršavanje. Problem s kojim su se grafičke kartice oduvijek
susretale jest usko grlo prebacivanja podataka iz radne memorije (RAM) u me-
moriju grafičke kartice (VRAM). Naime, aplikacije koje trebaju raditi u stvarnom
vremenu i koriste procesiranje na grafičkim karticama moraju pažljivo odabirati
trenutke kada će i koliko podataka prebaciti u memoriju grafičke kartice kako ne
bi došlo do zastoja.

4.3.2. OpenCV

Jedna od najpoznatijih i najfleksibilnih biblioteka za manipulaciju slikovim
elementima jest OpenCV – biblioteka za računalni vid u stvarnom vremenu. Pri-
marno je pisana u jeziku C++, ali sadrži ekstenzije za mnoge druge popularne
programske jezike poput Jave i Pythona. OpenCV svoje funkcije implementira
kroz CUDA i OpenCL sučelje zbog najveće efikasnosti. Automatski detektira
komponente sustava na kojemu se izvodi te koristi prigodne optimizirane funkcije
na grafičkim karticama ako je to moguće.

OpenCV sadrži mnoge funkcije za obradu i manipulaciju slika, učitavanje i
spremanje slika, primjena raznih transformacija te mnoge optimizirane algoritme
za računalni vid i strojno učenje. Centralni razred koji predstavlja slike u bibli-
oteci jest razred Mat. Podržava spremanje slika različitih tipova i dimenzija.
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4.4. Razvoj grafičkog sučelja u aplikaciji Photo-
Grade

U ovom poglavlju razmotrit će se razvoj grafičkog sučelja (GUI) u program-
skom jeziku Java uz pomoć biblioteke Swing za aplikaciju PhotoGrade. Općenito,
grafičko sučelje sastoji se od raznih vrsta gumbova, izbornika, klizača, tekstualnih
okvira i oznaka, slika, itd. (slika 4.3). Korisnik komunicira s grafičkim sučeljem
preko tipkovnice i miša.

U Swing-u grafički elementi se zovu komponente koje koji se mogu smjestiti
u razne kontejnere koji imaju svoj zadani razmještaj elemenata (engl. layout).
Swing ima svoju razvijenu hijerarhiju razreda iz koje su izgrađene razne kompo-
nente, kontejneri i naposljetku sami prozori (engl. window). Navedena hijerarhija
prikazana je na slici 4.4.

Slika 4.3: Osnovni elementi Swing GUI-a

Slika 4.4: Hijerarhija razreda u Swing-u
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Kako je izvođenje koda koji je zadužen za grafičko sučelje odvojen od glavne
logike programa, on se izvodi na drugoj dretvi (engl. thread) koja je zadužena
samo za prikazivanje grafičkih elemenata i njihovu asinkronu interakciju s drugim
dijelovima programa.

Glavni prozor u aplikaciji PhotoGrade (slika 4.5) sastoji se od glavnog iz-
bornika koji je izveden pomoću komponente JMenuBar te prikaz slike koja se
obrađuje. Prikaz slike je izveden pomoću komponente JLabel. Klikom na neki
od izbornika otvara se podizbornik (JMenu) s dodatnim alatima i izbornicima.
Odabirom nekog od alata koji se nalaze u podizbornicima otvara se dodatni pro-
zor za određivanje parametara alata. Parametri se namještaju pomoću klizača
(engl. slider) izvedenih iz komponente JSlider. Klikom na gumb Reset korisnik
vraća parametre u prvobitno stanje. Gumb Apply potvrđuje i sprema promjene
na slici, gumb Cancel poništava promjene i zatvara alat. Slika 4.6 prikazuje pro-
zor alata za upravljanje svjetlinom i kontrastom. Pokretanjem klizača mijenjaju
se parametri alata te korisnik u stvarnom vremenu vidi promjene na slici.

Slika 4.5: Glavni prozor aplikacijse PhotoGrade

Slika 4.6: Alat za upravljanje svjetlinom i kontrastom
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Svaki izbornik izveden je iz razreda Action koji je opće namjenski razred koji
pohranjuje akcije koje sadrže naziv i callback metodu koja će se izvesti kada se
akcija okine (engl. trigger). Akcije, također, mogu sadržavati sliku i akcelerator
– prečac za okidanje akcije. Izvorni kod 4.1 prikazuje stvaranje akcije Undo:

– Naziv: „Undo“

– Akcelerator: „ctrl + z“

– actionPreformed() je callback funkcija

1 private Action actionUndo = new MyAction ( "Undo" , " c on t r o l Z" , this ) {
2 @Override
3 public void act ionPerformed ( ActionEvent e ) {
4 photoChangeTracker . undo ( ) ;
5 showCurrentImge ( ) ;
6 }
7 } ;

Izvorni kod 4.1: Stvaranje akcije Undo

Dodavanje akcija u izbornik vrši se metodom add() pozvanom nad objektima
razreda JMenu.

Učitavanje fotografija vrši se izbornikom File→ Open. Zatim se otvara prozor
izveden razredom JFileChooser koji omogućava odabiranje datoteka na računalu
(slika 4.7).

Slika 4.7: Prozor za učitavanje slika
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4.4.1. Oblikovni obrazac promatrača

Grafičko sučelje je sustav temeljen na događajima. Kada korisnik klikne gumb,
nešto se treba dogoditi. Kada korisnik u aplikaciji PhotoGrade pomakne klizač,
očekivano je da će se slika osvježiti i prikazati trenutno stanje uređene slike s
promijenjenim parametrom koji je bio pridružen navedenom klizaču. Događaj
pritiska na gumb asinkrono treba pozvati neku funkciju koja će izvesti određeni
dio koda. Funkcije koje se pokreću na asinkrone događaje općenito se nazivaju
callback funkcije.

Oblikovni obrazac koji rješavam ovakav problem asinkronih događaja naziva
se obrazac promatrača (slika 4.8). Promatrači su objekti koji osluškuju događaje.
One će se pretplatiti subjektima da ih obavijeste kada se dogodi određeni događaj.
Kada ih subjekt obavijesti o određenom događaju, promatrači izvršavaju pripadne
callback funkcije.

U programskom jeziku Java, promatrači i subjekti implementirani su kao su-
čelja. Promatrači sadrže callback metodu update(). Subjekti sadrže metode
registerObserver(observer) i unregisterObserver(observer) pomoću kojih se pro-
matrači mogu pretplatiti i raskinuti pretplatu od subjekta. Naravno, subjekti
sadrže metodu notifyObservers() koja će obavijestiti sve promatrače o događaju
na koji su se pretplatili.

Slika 4.8: Oblikovni obrazac promatrača
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5. Ispitivanje funkcionalnosti
aplikacije PhotoGrade

5.1. Obrada tamne fotografije

Radi se s pretamnom slikom (slika 5.1, preuzeto s https://photographylife.

com/underexposure-and-overexposure-in-photography). Histogram ukazuje
kako se većina vrijednosti nalazi u području sjena.

Slika 5.1: Izvorna slika i njen histogram luminantne komponente

Cilj je posvijetliti sliku i istaknuti boje na zastavama. U prvom koraku (slika
5.2) je napravljena gamma korekcija. Zatim je blago pojačan kontrast pomoću
alata ‘Smart Brightness & Contrast’ (slika 5.3). Potom je pomoću alata HSV
smanjena saturacija boje na cijeloj slici čime je postignut efekt izblijedjelih boja
oko zastava (slika 5.4). Slika 5.5 prikazuje usporedbu izvorne i uređene slike.
Slika je posvijetljena te se boje ističu samo na zastavama.
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Slika 5.2: Korak 1 - gamma korekcija

Slika 5.3: Korak 2 - pojačanje kontrasta

Slika 5.4: Korak 3 - smanjenje saturacije

Slika 5.5: Usporedba izvorne i uređene slike
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5.2. Obrada svijetle fotografije

Radi se sa slikom 5.6 (preuzeta s https://photo.stackexchange.com/questions/

84495/can-my-overexposed-hazy-backlit-photo-be-fixed) koja je presvije-
tla. Cilj je urediti fotografiju tako da izaziva osjećaje nostalgije.

Slika 5.6: Izvorna slika

U prvom koraku (slika 5.7) se radi gamma korekcija kako bi se nelinearno smanjila
svjetlina na slici.

Slika 5.7: Korak 1 - gamma korekcija

49

https://photo.stackexchange.com/questions/84495/can-my-overexposed-hazy-backlit-photo-be-fixed
https://photo.stackexchange.com/questions/84495/can-my-overexposed-hazy-backlit-photo-be-fixed


Zatim se primjenjuje efekt sepia (slika 5.8) kako bi slika poprimila staromodan
izgled.

Slika 5.8: Korak 2 - sepia efekt

Sljedeće je slika blago izoštrena (slika 5.9) kako bi dječakovo lice bilo istaknutije
te kako bi se povećala zrnatost koja je svojstvena starijim fotografijama.

Slika 5.9: Korak 3 - izoštravanje
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Slika 5.10 prikazuje usporedbu izvorne i uređenih slika. Druga uređena slika je
odrezana kako bi se ostvarila centralna kompozicija.

Slika 5.10: Usporedba izvorne i uređene slike
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5.3. Obrada fotografija iz umjetničkih razloga

5.3.1. Primjer 1

Radi se sa slikom 5.11 koja se želi obraditi iz umjetničkih razloga. Dakle, cilj
nije tehnički popraviti fotografiju, već izazvati pobuđivanje osjećaja kod gledate-
lja. Način na koji umjetnička fotografija pobuđuje osjećaje kod gledatelja neće
biti opisan u ovome radu, već će se objasniti postupak kojim je slika preobražena
u alatu PhotoGrade.

Slika 5.11: Izvorna slika

U prvom koraku (slika 5.12) slika je pretvorena u crno-bijelu sliku (engl. grays-
cale).

Slika 5.12: Korak 1 - pretvorba u crno-bijelu sliku
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U drugom koraku (slika 5.13) primijenjeno je vertikalno zrcaljenje.

Slika 5.13: Korak 2 - vertikalno zrcaljenje

U trećem koraku (slika 5.14) napravljena je inverzija slike kako bi se postigao
efekt negativa filma.

Slika 5.14: Korak 3 - inverzija
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U četvrtom koraku (slika 5.15) pojačan je kontrast pomoću alata ‘Smart Bright-
ness & Contrast’.

Slika 5.15: Korak 4 - pojačanje kontrasta

U petom koraku (slika 5.16) slika je pobojana žutom bojom te je boja dodatno
prilagođena po želji alatom HSV.

Slika 5.16: Korak 5 - bojanje slike
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U završnom koraku slika je još odrezana kako bi se odrezao nepotreban prazan
prostor te centrirao kukac. Slika 5.17 prikazuje usporedbu izvorne i uređene
fotografije.

Slika 5.17: Usporedba izvorne i uređene slike
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5.3.2. Primjer 2

Radi se sa slikom 5.18 koja se želi obraditi iz umjetničkih razloga. Cilj je
obraditi fotografiju na način da izgleda nešto nalik crtežu.

Slika 5.18: Izvorna slika

U prvom koraku (slika 5.19) slika je pretvorena u crno-bijelu sliku (engl. grays-
cale).

Slika 5.19: Korak 1 - pretvorba u crno-bijelu sliku
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U drugom koraku (slika 5.20) slika je izoštrena.

Slika 5.20: Korak 2 - vertikalno zrcaljenje

U trećem koraku (slika 5.21) povećan je kontrast i prilagođena svjetlost.

Slika 5.21: Korak 3 - prilagodba svjetline i kontrasta
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U četvrtom koraku (slika 5.22) slika je obojana u nijansu žute.

Slika 5.22: Korak 4 - bojanje slike

U petom koraku (slika 5.23) slika je dodatno izoštrena i zamućena kako bi se
dobio željeni efekt.

Slika 5.23: Korak 5 - uglađivanje oštrine
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Slika 5.24 prikazuje usporedbu izvorne i uređene fotografije. Željeni efekt je
postignut pomoću alata PhotoGrade

Slika 5.24: Usporedba izvorne i uređene slike
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5.3.3. Primjer 3

Radi se s fotografijom 5.25. Cilj je poigrati se s granama na drvetu koje
nalikuju na paukovu mrežu.

Slika 5.25: Izvorna slika

Slika 5.26: Korak 1 - odsijecanje

U prvom koraku (slika 5.26) odrezan je dio slike na kojemu se nalaze grane. U
drugom koraku (slika 5.27) učinjeno je vertikalno zrcaljenje. U trećem koraku
(slika 5.28) slika je invertirana. U četvrtom koraku (slika 5.29), pomoću alata
HSV, pomaknute su boje i pojačana saturacija kako bi lišće bilo žuto-crveno. U
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petom koraku (slika 5.30) slika je dodatno izoštrena kako bi se istaknuli rubovi
i naglasila mrežna struktura. Slika 5.31 prikazuje usporedbu izvorne i uređene
fotografije.

Slika 5.27: Korak 2 - vertikalno zrcaljenje

Slika 5.28: Korak 3 - invertiranje
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Slika 5.29: Korak 4 - promijena boje

Slika 5.30: Korak 5 - izoštravanje
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Slika 5.31: Usporedba izvorne i uređene slike
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5.4. Fotografije uređene od korisnika

U ovom poglavlju prikazani su primjeri kako su korisnici iskoristili alat Pho-
toGrade za uređivanje fotografija. Sve osobe navedene u ovom poglavlju dale
su svoju suglasnost da se njihova imena i uređene fotografije, koje su njihovo
autorsko djelo, objave u ovom radu.

Fotografije su uređivali: Nevio Aradski (slike 5.32 - 5.39), Tihana Najdert
(slike 5.40 - 5.45), Emanuela Răileanu (slike 5.46 - 5.47), Leona Turković (slika
5.48) i Vladimir Šeba (slike 5.49 - 5.53).

Slika 5.32: Nevio Aradski - slika 1 - izvorna slika

Slika 5.33: Nevio Aradski - slika 1 - crno-bijela verzija
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Kako bi na fotografiji krajolika (slika 5.32) Nevio naglasio kompoziciju, pre-
tvorio je fotografiju u crno-bijelu (slika 5.33).

Slika 5.34: Nevio Aradski - slika 1 - verzija s dorađenim bojama

Nadalje, na drugoj verziji fotografije (slika 5.34) uredio je boje kako bi pro-
mijenio ugođaj kojim fotografija odiše.

Slika 5.35: Nevio Aradski - slika 2 - izvorna slika
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Slika 5.36: Nevio Aradski - slika 2 - hladna verzija

Slika 5.37: Nevio Aradski - slika 2 - topla verzija
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Toplu fotografiju plaže (slika 5.35) Nevio je pretvorio u hladnu i snježnu fo-
tografiju efektom invertiranja (slika 5.36). U drugoj verziji iste fotografije (slika
5.37), kako bi pojačao dojam topline, Nevio je malo povećao kontrast i saturaciju
slike.

Slika 5.38: Nevio Aradski - slika 3 - izvorna slika

Slika 5.39: Nevio Aradski - slika 3 - crno-bijela verzija

Fotografija 5.38 ima snažnu kompoziciju. Kako bi gledatelja usredotočio samo
na kompoziciju, Nevio je fotografiju pretvorio u crno-bijelu te doradio kontrast
(slika 5.39) .
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Pomoću efekta sepia, Tihana je fotografiju plaže (slika 5.40) pretvorila u uža-
renu pustinju (slika 5.41).

Slika 5.40: Tihana Najdert - slika 1 - izvorna slika

Slika 5.41: Tihana Najdert - slika 1 - sepia verzija
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Često fotografi imaju potrebu malo doraditi fotografije dobivene iz fotoaparata
pomoću upravljanja kontrastom i svjetlinom, odsijecanjem ili promjenom boja.
Takve dorade Tihana i Emanuela demonstriraju na slikama 5.42 - 5.47

Slika 5.42: Tihana Najdert - slika 2 - izvorna slika

Slika 5.43: Tihana Najdert - slika 2 - uređena verzija
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Slika 5.44: Tihana Najdert - slika 3 - izvorna slika

Slika 5.45: Tihana Najdert - slika 3 - uređena verzija
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(a) Prije (b) Poslije

Slika 5.46: Emanuela Răileanu - slika 1

(a) Prije (b) Poslije

Slika 5.47: Emanuela Răileanu - slika 2
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Odsijecanjem Leona je stavila fokus na bitan dio fotografije te promjenom
boje i kontrasta učinila ju zabavnom i stiliziranom (slika 5.48).

(a) Prije (b) Poslije

Slika 5.48: Le♥na Turković - uređena slika

Fotografiju koja prikazuje muškarca kako izvodi stoj na rukama (slika 5.49),
Vladimir ju je prvotno posvijetlio i alatom HSV pomaknuo boje tako da more i
majica postanu zelene (slika 5.50). Zatim, u sljedećoj verziji uređene fotografije,
Vladimir je napravio inverziju kako bi naglasio konturu tijela (slika 5.51). Na-
dalje, odrezao je fotografiju kako bi promijenio kompoziciju fotografije i u samo
središte pozornosti stavio tijelo koje izvodi gimnastički pokret te primijenio sepia
efekt kako bi promijenio ugođaj (slika 5.52). Naposljetku, kako bi zornije doča-
rao pokret koje tijelo izvodi u stoju na rukama, Vladimir je i samu fotografiju
okrenuo naopačke (slika 5.53).
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Slika 5.49: Vladimir Šeba - izvorna slika

Slika 5.50: Vladimir Šeba - uređena verzija 1
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Slika 5.51: Vladimir Šeba - uređena verzija 2

Slika 5.52: Vladimir Šeba - uređena verzija 3
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Slika 5.53: Vladimir Šeba - uređena verzija 4
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6. Zaključak

U ovom radu predstavljen je postupak izrade aplikacije za uređivanje foto-
grafija nazvane PhotoGrade te njezine funkcionalnosti i mogućnosti uporabe.
Aplikacija je napisana u programskom jeziku Java uz pomoć biblioteke OpenCV
korištene za manipulaciju slikovnih elemenata. Aplikacija PhotoGrade korisniku
pruža intuitivan način uređivanja fotografija. Uređivanje se obavlja kroz niz alata
koje aplikacija nudi. Svi alati rade po sličnom principu te korisnik na taj način
brzo usvaja način rada kroz koji može preoblikovati fotografije. Također, za
svaku promjenu koju korisnik napravi rezultat vidi u stvarnom vremenu. Ovo
je bitan aspekt aplikacije za uređivanje fotografija koji korisniku olakšava rad te
pomože pri bržem i boljem donošenju odluka. Svaka promjena s kojom je koris-
nik zadovoljan se sprema kako bi se u budućnosti korisnik mogao vratiti na nju
i eksperimentirati s daljnjim uređivanjem

Bitan aspekt izrade aplikacije za uređivanje fotografija jest razvijanje intuitiv-
nog grafičkog sučelja. Neočekivano, programiranje grafičkog sučelja bio je najviše
problematičan aspekt razvoja aplikacije. Naime, dio programskog koda odgo-
vornog za obradu fotografije je relativno kratak i jednostavan. Dok je s druge
strane, većinski ostatak programskog koda odgovoran za grafičko sučelje i njegovo
responzivno funkcioniranje u stvarnom vremenu. Također, problematičan dio ra-
zvoja bio je integriranje i korištenje različitih biblioteka koje nisu usklađene za
međusobno korištenje.

Odsijecanje, zrcaljenje, rotiranje, prilagodba svjetline i kontrasta te pretvorba
u crno-bijelu sliku su neki od najčešće korištenih alati pri korekciji fotografija.
PhotoGrade pruža svaki od tih alata te postiže zadovoljavajuće rezultate s njima.
Zamjerke idu na neintuitivan način odsijecanja pomoću klizača (engl. slider)
umjesto odabiranja područja slike pomoću metode klikni i povuci (engl. click
and drag) koja ocrtava pravokutnik. Također, veća fleksibilnost bila bi postig-
nuta rotiranjem slike pod svim kutevima, umjesto samo pod pravim. Prilagodba
svjetline i kontrasta u aplikaciji PhotoGrade jest fleksibilna te pruža korisniku
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fine razine uglađivanja.
Alati za prilagodbu boje pružaju korisniku izražavanje kreativnosti te reali-

ziranje, ponekad, nerealističnih fotografija. Prilagodba boje u aplikaciji Photo-
Grade nije fleksibilna te je potrebno pažljivo upravljati parametrima alata ako
se želi dobiti realistični rezultat. Usprkos tome, sasvim su prikladni za stvaranje
maštovitih, nadrealističnih, apstraktnih te stiliziranih slika u kojima se boje ne
ponašaju kao u stvarnosti.

Alat za izoštravanje primjereno služi naglašavanju detalja na fotografijama te
naglašavanju rubova. Također, može poslužiti kao alat ta izoštravanje zamućenih
fotografija. Zamućenje se može koristi kada želimo ugladiti oštre teksture na
slikama ili potpuno zamutiti fotografiju.

Često je potrebno obraditi samo neki određeni dio slike, npr. oko na fotografiji
portreta koje treba izoštriti, prilagoditi svjetlost i kontrast te promijeniti mu boju.
Iako PhotoGrade pruža sve ove funkcionalnosti, nema mogućnosti obrađivanja
samo određenih dijelova fotografije.

PhotoGrade, iako jednostavan, pruža korisniku niz osnovnih funkcionalnosti
za obradu fotografije kojima se može postići mnogo različitih zahtjeva. Adekva-
tan je za blage korekcije nad fotografijama. Izvrstan je u manipulaciji svjetlinom
i kontrastom te zahtjeva korisnikovu maštovitost pri korištenju alata za manipu-
laciju bojama.
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PhotoGrade – aplikacija za obradu digitalne fotografije
Hrvoje Ditrih

Sažetak

U radu je opisana izrada aplikacije za obradu digitalne fotografije koja je na-
zvana PhotoGrade. Objašnjeni su načini pohrane digitalne fotografije te osnovni
prostori boja. Detaljno su opisane metode obrade fotografije koje su korištene.
Aplikacija je razvijena u programskom jeziku Java uz pomoć biblioteke OpenCV.
Objašnjen je način izvedbe grafičkog sučelja u okruženju Swing te su navedene
problematike kod izvođenja operacija nad slikama u stvarnom vremenu. De-
monstriran je rad aplikacije kroz primjere uređivanja fotografija te su priložene
umjetničke fotografije koje su uredili korisnici pomoću aplikacije PhotoGrade.

Ključne riječi: PhotoGrade, digitalna obrada slike, uređivanje fotografija, Swing,
modeli boja

PhotoGrade – digital image editing software
Hrvoje Ditrih

Summary

This paper describes the development of a digital image editing software na-
med PhotoGrade. It explains how are digital images stored and describes basic
color spaces. Image processing methods are explained in detail. PhotoGrade was
developed in Java with the help of the OpenCV library. It demonstrates the de-
velopment of a graphical user interface with the Swing framework and introduces
the difficulties of executing image processing methods in real-time. PhotoGrade
is demonstrated through photo editing examples and artistic photographs that
the users edited with the help of PhotoGrade are attached.

Keywords: PhotoGrade, digital image processing, photo editing, Swing, color
spaces
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